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Chapter 1: 

Introduction to AI Forex Trading Robots  

An AI-powered Forex trading robot is an automated software program that 

uses Artificial Intelligence (AI) and Machine Learning (ML) techniques to 

analyze market data, make trading decisions, and execute trades in the foreign 

exchange (Forex) market without human intervention. These robots are 

designed to mimic human trading behavior but with the added advantage of 

speed, precision, and the ability to process vast amounts of data in real-time 

With AI Trading Robot Builder Guide, We can create or convert forex 

trading strategies to forex robot in ONE CLICK without coding 

knowledge needed 

No coding or technical expertise required - we makes it simple for anyone 

to build their own automated trading system. 

⚫ Maximize your trading potential and increase your profits with a 

personalized robot that suits your trading style. 

⚫ Take control of your Forex trading strategy with AI technology that learns 

and adapts to market conditions. 
⚫ Transform your forex strategy into a fully automated robot in just 

one click, Revolutionize your trading experience with cutting-edge 
technology, 

⚫ Eliminate human error and emotion from your trades, 
⚫ Maximize your profits with the precision and speed of artificial 

intelligence, 
⚫ Join the future of forex trading today with our AI Trading Robot 

Builder 

Its easy like 1,2,3…. 

1. Enter ai promt (or your own trading strategies & rules) to this AI tool > 

https://chat.deepseek.com/  

2. Click to start generate forex robot instantly in few seconds. 

3. Copy EA code 

4. Follow how to use EA code and done…  

5. Just copy EA code like below 

https://chat.deepseek.com/


 

 

Creating a fully functional Forex trading robot (also known as an Expert 

Advisor or EA) requires a combination of coding skills, trading knowledge, and 

a clear understanding of the strategy you want to implement.  

BUT now.. You can create forex trading robot in one CLICK without 

coding skill needed using AI tool. Just using AI promts to builde your EA 

instantly 

⚫ You can create EA using AI promts 

⚫ You can CONVERT your own forex trading strategy, rules and risk 

management if you have one. 

⚫ Create and Convert to forex trading robot in ONE CLICK 

⚫ Work for all code : MQL4, MQL5, Phyton 

 

 

 

 



 CHAPTER 2 

30+ AI prompts ready to use  

 

Below are 30+ AI prompts to help you design, develop, and optimize a Forex 

trading robot with different strategies. These prompts can be used with AI 

tools like ChatGPT or other AI-based coding assistants to generate code, 

refine logic, and test strategies. 

 

General Development Prompts 

1.Strategy Design: "Help me design a Forex trading strategy based on 

moving average crossovers. Include entry, exit, and risk management rules." 

 

2.Code Structure: "Provide a template for a MetaTrader 4 (MT4) Expert 

Advisor in MQL4 that includes placeholders for strategy logic, risk 

management, and trade execution." 

 

3.Backtesting: "How can I backtest a Forex trading robot using historical data 

in MT4? Provide step-by-step instructions." 

 

4.Optimization: "Explain how to optimize a Forex EA using the MetaTrader 

Strategy Tester. What parameters should I focus on?" 

 

5.Risk Management: "Create a risk management system for a Forex EA that 

includes lot size calculation based on account balance and stop-loss 

placement." 

 

Strategy-Specific Prompts 

1.Trend-Following Strategy: "Write the MQL4 code for a trend-following 

Forex EA that uses the ADX indicator to identify trends and the RSI to confirm 

entries." 

 

2.Scalping Strategy: "Develop a scalping Forex EA that uses Bollinger Bands 

to identify overbought/oversold conditions and executes trades with a tight 

stop-loss." 

 



3.Breakout Strategy: "Create a Forex EA that trades breakouts using the 

Average True Range (ATR) indicator to set dynamic stop-loss and take-profit 

levels." 

 

4.Grid Trading Strategy: "Design a grid trading EA that places buy and sell 

orders at predefined intervals and closes trades when a profit target is 

reached." 

 

5.Hedging Strategy: "Write the code for a hedging EA that opens opposite 

trades when a certain drawdown is reached to minimize losses." 

 

 

 

Indicator-Based Prompts 

6.MACD Strategy: "Develop a Forex EA that uses the MACD indicator to 

generate buy/sell signals and includes a trailing stop feature." 

 

7.RSI Strategy: "Create an EA that uses the RSI indicator to identify 

overbought/oversold conditions and executes trades with a fixed lot size." 

 

8.Ichimoku Strategy: "Write the MQL4 code for an EA that uses the Ichimoku 

Cloud to identify trend direction and generate trade signals." 

 

9.Moving Average Strategy: "Design an EA that uses two moving averages 

(e.g., 50-period and 200-period) to generate crossover signals for entries and 

exits." 

 

10.Stochastic Strategy: "Create a Forex EA that uses the Stochastic Oscillator 

to identify divergence and generate trade signals." 

 

 

Advanced Features Prompts 

 

11.Multi-Timeframe Analysis: "How can I implement multi-timeframe 

analysis in a Forex EA? Provide an example using the 1-hour and 4-hour 

charts." 

 

12.News Filter: "Add a news filter to a Forex EA that avoids trading during 

high-impact economic news events. Use an external API for news data." 



13.Machine Learning Integration: "How can I integrate a machine learning 

model into a Forex EA to improve trade predictions? Provide a basic example 

using Python and MQL4." 

 

14.Trailing Stop: "Write the code for a trailing stop feature in a Forex EA that 

adjusts the stop-loss as the trade moves in a favorable direction." 

 

15.Trade Journaling: "Create a trade journaling system for a Forex EA that 

logs all trades, including entry price, exit price, profit/loss, and trade duration." 

 

 

Testing and Deployment Prompts 

⚫ Forward Testing: "Explain how to forward test a Forex EA on a demo 

account to evaluate its performance in real-time market conditions." 

⚫ Monte Carlo Simulation: "How can I use Monte Carlo simulation to test 

the robustness of a Forex EA? Provide a step-by-step guide." 

⚫ Deployment: "What are the best practices for deploying a Forex EA on a 

live trading account? Include tips for monitoring and managing the EA." 

 

Additional Tips 

⚫ Use AI tools to generate the initial code, but always review and test it 

thoroughly before deploying it on a live account. 

⚫ Combine multiple strategies or indicators to create a more robust trading 

system. 

⚫ Continuously monitor and optimize the EA based on market conditions 

and performance metrics. 

 

By using these prompts, you can leverage AI to create, refine, and deploy a 

fully functional Forex trading robot tailored to your specific trading style and 

goals 
 
 
 
 

 



20+ detailed AI prompts designed to 
help you develop fully functional Forex 
trading robots with various strategies 

 

Okay, here are 20+ AI prompts designed to help you develop fully functional 
Forex trading robots with various strategies. These prompts are designed to 
be detailed, helping an AI model understand the specific requirements of each 
trading strategy. Remember to tailor these prompts to the specific AI tool you 
are using (e.g., ChatGPT, Bard, etc.) and provide context about your 
preferred programming language (e.g., MQL4/5 for MetaTrader, Python, etc.). 

Before you start, consider the following for each robot: 

• Risk Management: Specify stop-loss, take-profit, lot size calculation 
methods, and maximum drawdown. 

• Market Conditions: Define what market conditions the robot should 
operate in (e.g., trending, sideways, volatile). 

• Currency Pairs: State which currency pairs the robot is intended for. 
• Timeframes: Specify the timeframe(s) to be used (e.g., M15, H1, D1). 
• Backtesting and Optimization: Mention that the code should be 

easily adaptable for backtesting and parameter optimization. 
• Error Handling: Request robust error handling and logging. 
• Alerts: Include functions for sending alerts (email, push notifications) 

for significant events. 

Here are the 20+ Prompts: 

Trend Following Strategies: 

1. Prompt: "Create a Forex trading robot for MetaTrader 5 (MQL5) that 
implements a moving average crossover strategy. Use a fast moving average 
(e.g., 20-period EMA) and a slow moving average (e.g., 50-period EMA). 
When the fast MA crosses above the slow MA, enter a long position. When 
the fast MA crosses below the slow MA, enter a short position. Include a 
trailing stop loss that adjusts dynamically based on the Average True Range 
(ATR). Implement a money management system that risks 1% of the account 
balance per trade. Incorporate robust error handling and logging. Target 
currency pair: EUR/USD. Timeframe: H1." 

 

2. Prompt: "Develop a Forex trading robot in Python using the ccxt library 
that uses the Parabolic SAR indicator to identify trend direction. Enter a long 



position when SAR flips to bullish, and a short position when SAR flips to 
bearish. Implement a stop-loss based on the previous swing low (for long 
positions) or swing high (for short positions). Implement a take-profit level 
based on a fixed risk-reward ratio of 1:2. Backtesting functionality is crucial. 
Currency pair: GBP/USD. Timeframe: M30." 

3.Prompt: "Write MQL4 code for a Forex robot that follows the trend using 
the ADX (Average Directional Index) indicator. The robot should only enter 
trades when the ADX is above a certain threshold (e.g., 25), indicating a 
strong trend. If +DI is above -DI, go long. If -DI is above +DI, go short. 
Include a stop-loss based on a fixed percentage of the entry price (e.g., 2%). 
Optimize the ADX threshold value. Currency pair: USD/JPY. Timeframe: D1." 

4.Prompt: "Create a Forex robot using the Ichimoku Cloud indicator. Entry 
conditions: long when price breaks above the cloud, the Tenkan-sen is above 
the Kijun-sen, and the Chikou Span is above the price. Short when the price 
breaks below the cloud, the Tenkan-sen is below the Kijun-sen, and the 
Chikou Span is below the price. Use the Kijun-sen as a trailing stop loss. 
Programmed in MQL5. Currency pair: AUD/USD. Timeframe: H4." 

 

Range Trading Strategies: 

5.Prompt: "Develop a Forex trading robot in Python that identifies ranging 
markets using Bollinger Bands. Go long when the price touches the lower 
band and short when the price touches the upper band. Set a take-profit at 
the middle band (SMA) and a stop-loss just outside the respective Bollinger 
Band. Include dynamic lot sizing based on account balance and volatility. 
Currency pair: EUR/GBP. Timeframe: M15." 

6.Prompt: "Create an MQL4 robot that trades within a defined price range 
identified by support and resistance levels. These levels should be 
automatically calculated based on the highest high and lowest low of the past 
X periods (input parameter). If the price bounces off support, go long. If the 
price bounces off resistance, go short. Implement a stop-loss just below the 
support level for long positions and just above the resistance level for short 
positions. Currency pair: USD/CAD. Timeframe: H1." 

7.Prompt: "Write code for a Forex robot that uses the RSI (Relative Strength 
Index) to identify overbought and oversold conditions in a ranging market. Go 
long when RSI is below 30 and short when RSI is above 70. Include a filter to 
only trade during specific hours of the day (e.g., Asian session). Backtest 
different RSI levels for optimal performance. Programming language: MQL5. 
Currency pair: NZD/USD. Timeframe: M30." 

 



Breakout Strategies: 

8.Prompt: "Develop a Forex trading robot in MQL5 that trades breakouts 
from a consolidation pattern identified by the Average True Range (ATR). If 
the ATR is below a certain threshold (indicating low volatility), the robot 
should monitor for a breakout. When the price breaks above the high of the 
last X candles (input parameter) go long. When the price breaks below the 
low of the last X candles, go short. Implement a stop-loss based on the ATR. 
Currency pair: GBP/JPY. Timeframe: H1." 

9.Prompt: "Create a Python-based Forex robot that identifies breakouts 
using pivot point levels. Enter a long position when the price breaks above 
the R1 pivot point level, and a short position when the price breaks below the 
S1 pivot point level. Use the daily pivot point as a trailing stop loss. 
Implement a risk management system that adjusts lot size based on account 
balance and the distance to the stop-loss. Currency pair: EUR/USD. 
Timeframe: M30." 

10.Prompt: "Write MQL4 code for a Forex robot that trades based on the 
London Breakout strategy. Define a range based on the high and low prices 
from the previous London session (e.g., 8 AM to 9 AM GMT). Enter a long 
position when the price breaks above the high of the range, and a short 
position when the price breaks below the low of the range. Set a fixed take-
profit and stop-loss based on the range size. Currency pair: GBP/USD. 
Timeframe: M15." 

Scalping Strategies: 

11.Prompt: "Develop an MQL5 Forex scalping robot that uses the Stochastic 
Oscillator to identify short-term overbought and oversold conditions. Enter a 
long position when the Stochastic Oscillator crosses above 20, and a short 
position when it crosses below 80. Use very tight stop-loss and take-profit 
levels (e.g., 5-10 pips). The robot should only trade during periods of high 
volatility (e.g., during news releases). Currency pair: EUR/USD. Timeframe: 
M1." 

12.Prompt: "Create a Python Forex scalping robot that uses a combination 
of moving averages (e.g., 5-period SMA and 10-period SMA) and the RSI to 
identify quick trading opportunities. Enter a long position when the fast MA 
crosses above the slow MA and the RSI is below 50. Enter a short position 
when the fast MA crosses below the slow MA and the RSI is above 50. Use a 
fixed stop-loss and take-profit of 3-5 pips. Currency pair: USD/JPY. Timeframe: 
M1." 

13.Prompt: "Write MQL4 code for a scalping robot that trades based on 
order book data (if available through the broker's API). The robot should 
identify areas of high buy or sell pressure and enter positions accordingly. Use 
a very short timeframe (e.g., M1) and tight stop-loss and take-profit levels. 



Implement robust error handling to account for API disconnections. Currency 
Pair: EUR/USD. Timeframe: M1." 

Counter-Trend Strategies: 

14.Prompt: "Develop an MQL5 Forex robot that trades against the current 
trend using the Fibonacci retracement levels. Identify the recent swing high 
and swing low, and then enter a short position at the 61.8% Fibonacci 
retracement level of the upward swing, or enter a long position at the 61.8% 
level of the downward swing. Set a stop-loss just above the swing high (for 
short positions) or just below the swing low (for long positions). Currency Pair: 
AUD/USD. Timeframe: H1." 

15.Prompt: "Create a Python-based Forex robot that uses the MACD 
(Moving Average Convergence Divergence) indicator to identify potential 
trend reversals. Enter a long position when the MACD line crosses above the 
signal line in oversold territory, and a short position when the MACD line 
crosses below the signal line in overbought territory. Implement a trailing 
stop loss based on the ATR. Currency pair: GBP/JPY. Timeframe: H4." 

16.Prompt: "Write code for a Forex robot that uses divergence between 
price and the RSI indicator to identify potential trend reversals. Enter a long 
position when the price makes a lower low, but the RSI makes a higher low 
(bullish divergence). Enter a short position when the price makes a higher 
high, but the RSI makes a lower high (bearish divergence). Use MQL4, and 
the currency pair USD/CAD. Timeframe: H1." 

News Trading Strategies: 

17.Prompt: "Develop a Forex trading robot in Python that automatically 
trades based on economic news releases. The robot should subscribe to an 
economic calendar API (e.g., ForexFactory) and monitor for high-impact news 
events. Implement logic to place pending orders (buy stop and sell stop) 
shortly before the news release, anticipating a price breakout. Include robust 
error handling and news event filtering mechanisms. Currency pair: EUR/USD. 
Timeframe: M5." 

18.Prompt: "Create an MQL5 robot that trades Non-Farm Payroll (NFP). The 
robot should place buy stop and sell stop orders 2 minutes before the news 
release. Stop-loss must be dynamic based on ATR. Take-profit should be 
twice the risk. The Lot Size must be calculated based on a maximum of 2% 
account risk. Currency Pair: USD/JPY. Timeframe: M1." 

Arbitrage Strategies (Requires Understanding of Multiple 
Brokers/Data Feeds): 

19.Prompt: "Develop a Forex arbitrage robot in Python that exploits price 
discrepancies between two different brokers. The robot should connect to the 



APIs of both brokers and continuously monitor the price of a currency pair 
(e.g., EUR/USD). When a significant price difference is detected, the robot 
should simultaneously buy the currency pair at the lower price and sell it at 
the higher price. Implement robust latency monitoring and order execution 
logic. This will require the ability to handle multiple connections and 
asynchronous processing. Timeframe: M1." 

20.Prompt: "Create an MQL5 arbitrage robot that will compare the price of a 
currency pair (e.g., GBP/USD) from the broker it is running on, with the price 
from a reliable third-party data feed. When a significant difference is observed, 
enter a trade. It must have extremely fast execution capabilities. The robot 
must also monitor for and automatically disconnect from the datafeed if 
latency is too high. Timeframe: M1." 

 

Neural Network/Machine Learning Based Strategies (Requires More 
Advanced Knowledge): 

21.Prompt: "Develop a Forex trading robot in Python that uses a recurrent 
neural network (RNN), specifically an LSTM, to predict future price 
movements. The robot should be trained on historical price data and technical 
indicators (e.g., MACD, RSI, moving averages). Implement a trading strategy 
based on the RNN's predictions, including stop-loss and take-profit levels. 
Include functionality for continuously retraining the model as new data 
becomes available. Currency pair: EUR/USD. Timeframe: H1." 

22.Prompt: "Create an MQL5 robot that uses a feed-forward neural network 
to classify market states (e.g., trending, ranging, volatile). The input features 
for the neural network should include technical indicators (e.g., ADX, ATR, 
RSI) and price data. The robot should then use a different trading strategy 
based on the identified market state. Include functionality for backtesting and 
optimizing the neural network's parameters. Currency Pair: GBP/JPY. 
Timeframe: H4." 

Grid Trading Strategies: 

23.Prompt: "Develop an MQL5 Forex trading robot that implements a grid 
trading strategy. The robot should place a series of buy and sell orders at 
fixed price intervals above and below the current price. Implement a 
martingale or anti-martingale money management system. Include a 
maximum number of grid levels and a total drawdown limit. Currency pair: 
EUR/USD. Timeframe: M15." 

24.Prompt: "Create a Python-based Forex robot that uses a dynamic grid 
trading strategy. The grid spacing should be automatically adjusted based on 
the current market volatility (e.g., ATR). Implement a stop-loss for the entire 



grid and a take-profit for each individual order. Currency Pair: USD/CAD. 
Timeframe: H1." 

Martingale/Anti-Martingale Strategies (Use with Extreme Caution): 

25.Prompt: "Develop an MQL5 Forex trading robot that implements a 
martingale money management system. The robot should double the lot size 
after each losing trade. Include a maximum number of martingale levels and 
a total drawdown limit. Currency pair: EUR/USD. Timeframe: M5. WARNING: 
This strategy is extremely risky and can lead to rapid account 
depletion. Include multiple safeguards and warnings." 

26.Prompt: "Create a Python-based Forex robot that uses an anti-martingale 
(or reverse martingale) money management system. The robot should 
increase the lot size after each winning trade and decrease it after each losing 
trade. Implement a maximum lot size limit. Currency Pair: GBP/USD. 
Timeframe: M15." 

Custom Indicator Based Strategies: 

1. Prompt: "Develop an MQL5 Forex trading robot that uses a custom 
indicator (provide the code or a description of the indicator's logic). 
The robot should enter a long position when the custom indicator 
generates a buy signal and a short position when it generates a sell 
signal. Include adjustable parameters for the custom indicator and a 
stop-loss based on the ATR. Currency Pair: AUD/USD. Timeframe: H1." 

Hedging Strategies: 

1. Prompt: "Develop an MQL5 Forex trading robot that implements a 
hedging strategy. The robot should monitor two highly correlated 
currency pairs (e.g., EUR/USD and GBP/USD). When a divergence is 
detected between the two pairs, the robot should open opposing 
positions (long on one pair and short on the other). Close the positions 
when divergence normalizes or reaches a set profit level. Currency 
Pairs: EUR/USD and GBP/USD. Timeframe: M30." 

Order Flow based Strategies: 

1. Prompt: "Develop a Python Forex trading robot that analyzes order 
book data (if available) to identify significant areas of buying and 
selling pressure. It uses this data to determine possible direction, and 
then uses common confirmations to confirm. Currency pair: USD/JPY. 
Timeframe: M5." 

 

 



Combining Strategies: 

1. Prompt: "Develop an MQL5 Forex trading robot that combines the 
moving average crossover strategy (using 20 and 50 period EMAs) with 
the RSI indicator. The robot should only enter a long position when the 
fast MA crosses above the slow MA and the RSI is below 50. 
Conversely, it should only enter a short position when the fast MA 
crosses below the slow MA and the RSI is above 50. Implement a 
trailing stop loss based on the ATR. Currency pair: EUR/USD. 
Timeframe: H1." 

Important Considerations: 

• Thorough Backtesting: Stress the importance of rigorous 
backtesting on historical data and forward testing on a demo account 
before deploying any robot to a live account. 

• Parameter Optimization: Ensure the code allows for easy parameter 
optimization to find the best settings for different market conditions. 

• Risk Management: Emphasize the need for robust risk management 
features, including stop-loss orders, take-profit orders, and position 
size limits. 

• Broker Compatibility: The strategy and code must be compatible 
with the specific broker's execution policies (e.g., minimum order sizes, 
stop levels). 

• Platform Limitations/API: Understand limitations of chosen 
platform and available APIs, particularly when using multiple brokers or 
needing high-speed order execution. 

By providing these detailed prompts to an AI model, you can generate code 
that is more likely to meet your specific requirements for a Forex trading 
robot. Remember to review and test the generated code thoroughly before 
using it in a live trading environment. Good luck 

 

 

 

 

 



Chapter 3:  

How to build trading robot in ONE CLICK 

HERE HOW ITS WORK TO START CREATE FOREX ROBOT WITH AI PROMTS  

Just Paste ai Promt to Deepseek 

https://chat.deepseek.com/ 

Its easy like 1,2,3…. 

⚫ Enter ai promt (or your own trading strategies & rules) to this AI tool  

⚫ Click to start generate forex robot instantly in few seconds. 

⚫ Copy EA code 

⚫ Follow how to use EA code and done 

⚫ NO COST and UNLIMITED.. Create as much EA as you want. 

 

I use Combining Strategies promt below : 

Develop an MQL5 Forex trading robot that combines the moving average 
crossover strategy (using 20 and 50 period EMAs) with the RSI indicator. The 
robot should only enter a long position when the fast MA crosses above the 
slow MA and the RSI is below 50. Conversely, it should only enter a short 
position when the fast MA crosses below the slow MA and the RSI is above 50. 
Implement a trailing stop loss based on the ATR. Currency pair: EUR/USD. 
Timeframe: H1 

And input to : https://chat.deepseek.com/ 

 

https://chat.deepseek.com/
https://chat.deepseek.com/


 

And get amazing result like this : 
 
 

 
 
NOTES :  
 
⚫ Just click “Copy” to copy forex robot code 
⚫ Follow how EA works and  
⚫ Follow How to use guide 
 
 
 
Complete result like below : 
 

Below is an MQL5 Forex trading robot that combines the Moving Average 

Crossover strategy (using 20 and 50 period EMAs) with the RSI indicator. 

The robot enters a long position when the fast EMA crosses above the slow 

EMA and the RSI is below 50. Conversely, it enters a short position when the 

fast EMA crosses below the slow EMA and the RSI is above 50. It also 

implements a trailing stop loss based on the ATR. 

 

MQL5 Code: EMA Crossover + RSI + ATR Trailing Stop EA 

//+------------------------------------------------------------------+ 
//|                                                      EMA_RSI_ATR_EA.mq5 | 



//|                        EMA Crossover + RSI + ATR Trailing Stop    | 
//+------------------------------------------------------------------+ 
#property copyright "Your Name" 
#property version   "1.00" 
#property strict 
 
// Input parameters 
input double LotSize = 0.1;          // Lot size for trading 
input int FastMAPeriod = 20;         // Fast MA period (e.g., 20 EMA) 
input int SlowMAPeriod = 50;         // Slow MA period (e.g., 50 EMA) 
input int RSIPeriod = 14;            // RSI period 
input double RSIOverbought = 50;     // RSI threshold for short entry 
input double RSIOversold = 50;       // RSI threshold for long entry 
input int ATRPeriod = 14;            // ATR period for trailing stop 
input double ATRMultiplier = 2.0;    // ATR multiplier for trailing stop 
input ulong MagicNumber = 123456;    // Magic number for trades 
input int Slippage = 3;              // Slippage in pips 
 
// Global variables 
int FastMAHandle, SlowMAHandle, RSIHandle, ATRHandle; 
double FastMA[], SlowMA[], RSI[], ATR[]; 
CTrade trade; 
 
//+------------------------------------------------------------------+ 
//| Expert initialization function                                   | 
//+------------------------------------------------------------------+ 
int OnInit() 
  { 
   // Initialize indicator handles 
   FastMAHandle = iMA(_Symbol, _Period, FastMAPeriod, 0, MODE_EMA, 
PRICE_CLOSE); 
   SlowMAHandle = iMA(_Symbol, _Period, SlowMAPeriod, 0, MODE_EMA, 
PRICE_CLOSE); 
   RSIHandle = iRSI(_Symbol, _Period, RSIPeriod, PRICE_CLOSE); 
   ATRHandle = iATR(_Symbol, _Period, ATRPeriod); 
 
   // Check if handles are valid 
   if (FastMAHandle == INVALID_HANDLE || SlowMAHandle == 
INVALID_HANDLE || RSIHandle == INVALID_HANDLE || ATRHandle == 
INVALID_HANDLE) 
     { 
      Print("Error creating indicator handles"); 
      return(INIT_FAILED); 
     } 
 
   // Set buffer sizes 
   ArraySetAsSeries(FastMA, true); 
   ArraySetAsSeries(SlowMA, true); 



   ArraySetAsSeries(RSI, true); 
   ArraySetAsSeries(ATR, true); 
 
   return(INIT_SUCCEEDED); 
  } 
 
//+------------------------------------------------------------------+ 
//| Expert deinitialization function                                 | 
//+------------------------------------------------------------------+ 
void OnDeinit(const int reason) 
  { 
   // Release indicators 
   IndicatorRelease(FastMAHandle); 
   IndicatorRelease(SlowMAHandle); 
   IndicatorRelease(RSIHandle); 
   IndicatorRelease(ATRHandle); 
  } 
 
//+------------------------------------------------------------------+ 
//| Expert tick function                                             | 
//+------------------------------------------------------------------+ 
void OnTick() 
  { 
   // Get indicator values 
   if (CopyBuffer(FastMAHandle, 0, 0, 2, FastMA) < 2 || 
CopyBuffer(SlowMAHandle, 0, 0, 2, SlowMA) < 2 || 
       CopyBuffer(RSIHandle, 0, 0, 2, RSI) < 2 || CopyBuffer(ATRHandle, 0, 0, 
1, ATR) < 1) 
     { 
      Print("Error copying indicator buffers"); 
      return; 
     } 
 
   // Check for open positions 
   bool hasOpenPosition = PositionSelect(_Symbol); 
 
   // Entry logic 
   if (!hasOpenPosition) 
     { 
      // Buy signal: Fast EMA crosses above Slow EMA and RSI < 50 
      if (FastMA[0] > SlowMA[0] && FastMA[1] <= SlowMA[1] && RSI[0] < 
RSIOversold) 
        { 
         double lotSize = CalculateLotSize(); 
         double stopLoss = Bid - ATR[0] * ATRMultiplier; 
         double takeProfit = 0; // No fixed take-profit 
         trade.Buy(lotSize, _Symbol, Ask, stopLoss, takeProfit, "Buy Order"); 
        } 



 
      // Sell signal: Fast EMA crosses below Slow EMA and RSI > 50 
      if (FastMA[0] < SlowMA[0] && FastMA[1] >= SlowMA[1] && RSI[0] > 
RSIOverbought) 
        { 
         double lotSize = CalculateLotSize(); 
         double stopLoss = Ask + ATR[0] * ATRMultiplier; 
         double takeProfit = 0; // No fixed take-profit 
         trade.Sell(lotSize, _Symbol, Bid, stopLoss, takeProfit, "Sell Order"); 
        } 
     } 
 
   // Trailing stop logic 
   if (hasOpenPosition) 
     { 
      ulong ticket = PositionGetInteger(POSITION_TICKET); 
      double currentStopLoss = PositionGetDouble(POSITION_SL); 
      double currentPrice = PositionGetInteger(POSITION_TYPE) == 
POSITION_TYPE_BUY ? Bid : Ask; 
      double newStopLoss = currentStopLoss; 
 
      if (PositionGetInteger(POSITION_TYPE) == POSITION_TYPE_BUY) 
        { 
         newStopLoss = currentPrice - ATR[0] * ATRMultiplier; 
         if (newStopLoss > currentStopLoss) 
           { 
            trade.PositionModify(ticket, newStopLoss, 
PositionGetDouble(POSITION_TP)); 
           } 
        } 
      else if (PositionGetInteger(POSITION_TYPE) == POSITION_TYPE_SELL) 
        { 
         newStopLoss = currentPrice + ATR[0] * ATRMultiplier; 
         if (newStopLoss < currentStopLoss) 
           { 
            trade.PositionModify(ticket, newStopLoss, 
PositionGetDouble(POSITION_TP)); 
           } 
        } 
     } 
  } 
 
//+------------------------------------------------------------------+ 
//| Calculate lot size based on account balance and risk             | 
//+------------------------------------------------------------------+ 
double CalculateLotSize() 
  { 
   double accountBalance = AccountInfoDouble(ACCOUNT_BALANCE); 



   double riskAmount = accountBalance * 0.01; // Risk 1% of account balance 
   double tickValue = SymbolInfoDouble(_Symbol, 
SYMBOL_TRADE_TICK_VALUE); 
   double lotSize = riskAmount / (ATR[0] * ATRMultiplier * tickValue); 
   lotSize = NormalizeDouble(lotSize, 2); // Round to 2 decimal places 
   return lotSize; 
  } 
 
//+------------------------------------------------------------------+ 

 

How the EA Works 

Indicators: 

 

⚫ Fast EMA (20-period) and Slow EMA (50-period): Used to identify trend 

direction. 

⚫ RSI (14-period): Used to confirm overbought/oversold conditions. 

⚫ ATR (14-period): Used to calculate the trailing stop loss. 

 

Entry Rules: 

 

⚫ Buy Signal: Fast EMA crosses above Slow EMA and RSI < 50. 

⚫ Sell Signal: Fast EMA crosses below Slow EMA and RSI > 50. 

 

Trailing Stop Loss: 

 

⚫ The trailing stop is based on the ATR value multiplied by a user-defined 

multiplier (e.g., 2x ATR). 

⚫ The stop loss is adjusted as the price moves in favor of the trade. 

 

Risk Management: 

 

⚫ The lot size is calculated based on 1% risk of the account balance and the 

ATR value. 

 



input Parameters 

⚫ LotSize: Fixed lot size for trading (optional if using risk-based lot sizing). 

⚫ FastMAPeriod: Period for the fast EMA (default: 20). 

⚫ SlowMAPeriod: Period for the slow EMA (default: 50). 

⚫ RSIPeriod: Period for the RSI (default: 14). 

⚫ RSIOverbought: RSI threshold for short entry (default: 50). 

⚫ RSIOversold: RSI threshold for long entry (default: 50). 

⚫ ATRPeriod: Period for the ATR (default: 14). 

⚫ ATRMultiplier: Multiplier for the ATR trailing stop (default: 2.0). 

⚫ MagicNumber: Unique identifier for trades opened by this EA. 

⚫ Slippage: Maximum allowed slippage in pips (default: 3). 

 

 

How to Use 

⚫ Copy the code into a new Expert Advisor file in MetaEditor (File > New > 

Expert Advisor). 

⚫ Save the file as EMA_RSI_ATR_EA.mq5.EMA_RSI_ATR_EA.mq5 

⚫ Compile the code (Ctrl + F7). 

⚫ Attach the EA to an EUR/USD H1 chart in MetaTrader 5. 

⚫ Set the input parameters according to your preferences. 

⚫ Run the EA in a demo account to test its performance. 

 

 

Backtesting and Optimization 

⚫ Backtest: Test the EA on historical data to evaluate its performance. 

⚫ Optimize: Use the MetaTrader Strategy Tester to optimize parameters like 
FastMAPeriod SlowMAPeriod RSIPeriod and ATRMultiplier 

 

Disclaimer 

⚫ This EA is for educational purposes only. Always test it thoroughly in a 

demo account before using it in live trading. 

⚫ Past performance is not indicative of future results. Use proper risk 

management. 

 
 



Again… Its easy like 1,2,3….  

Now You can create forex trading robot in one click or 

convert your trading strategies into EA instantly.. 

⚫ Enter ai promt (or your own trading strategies & rules) to this AI tool  

⚫ Click to start generate forex robot instantly in few seconds. 

⚫ Copy EA code 

⚫ Follow how to use EA code and done 

⚫ You can test and use it if you already have forex trading account 
⚫ Or you can test with forex trading platform below: 

 
Best Recommend Forex Broker using MT4 or MT5 
 
 
⚫ FBS Trading Platform : Allow all trading strategies and EAs, Low minimum 

deposit and fast deposit/withdrawal process 
⚫ Headway Trading Platform : More better trading platform for EA 
⚫ You can try DEMO trading first, Instal MT4 or MT5 to try and test your 

own Forex Trading Robot 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

https://fbs.partners/?ibl=189948&ibp=1139486
https://headway.partners/landings/id/bonus-111/?hwp=bc8713


Chapter 4: 

How to convert your own trading strategies 

to AI trading robot instantly 

 

How To Convert Your Own Forex Trading Strategy to AI 
Trading Robot: A Step-by-Step Guide 

Instantly convert your own winning trading strategies to AI Trading Robot 
with deepseek in ONE CLICK 

⚫ Create your own promt : You can copy from 30+ ai promts above and 
change parameter with your own settings : Trading strategy, Code ( MQL4, 
MQL5, PHYTON etc.) PAIR, stop loss, trailing stop, risk management,  etc. 

⚫ Enter your AI promt to : https://chat.deepseek.com/ 
⚫ Click button to start generate robot trading code and wait few seconds 

untill completed 
⚫ Copy trading robot Code and save file as :  filename.mq4 or 

filename.mq5 
⚫ Read and follow “How EA Works” 
⚫ Read and follow step by step “How to use” guide 
⚫ Back testing : Test your new EA with your trading platform (DEMO) 
⚫ Forward  Testing : Test you EA in real market 

Just enter your own promt to deepseek like below: 

 

 

 

 

https://chat.deepseek.com/


Chapter 5: 

Building the AI-Powered Forex Trading 

Robot 

The allure of automated forex trading, promising consistent profits and 24/7 
market monitoring, is undeniable. However, transitioning from a manual 
trading strategy to a fully functional AI-powered robot requires a meticulous 
and phased approach. This guide outlines the key steps involved, focusing on 
clarity and practicality. 

Phase 1: Developing a Robust Forex Trading Strategy 

Before even considering automation, you need a winning trading strategy. 
This isn't about picking a random indicator; it's about rigorous backtesting 
and forward testing to validate its performance. 

⚫ Define Your Trading Style: Are you a scalper, day trader, swing trader, 
or long-term investor? Your chosen timeframe drastically impacts strategy 
design. 

⚫ Identify Key Indicators and Signals: Research and select indicators 
relevant to your style. This might include moving averages, RSI, MACD, 
Bollinger Bands, or more sophisticated indicators like the Average 
Directional Index (ADX). Avoid "holy grail" indicator claims; focus on 
combinations that consistently provide actionable signals. 

⚫ Develop Entry and Exit Rules: Precisely define when you enter and 
exit trades based on your chosen indicators. This must include stop-loss 
and take-profit levels to manage risk effectively. Avoid ambiguity; your 
rules must be clear and easily translatable into code. 

⚫ Backtesting: Use historical forex data to test your strategy's 
performance. Backtesting platforms like Metatrader's Strategy Tester or 
dedicated services offer this functionality. Analyze key metrics like win 
rate, average win/loss ratio, maximum drawdown, and Sharpe ratio. 
Focus on statistically significant results, not anecdotal evidence. 

⚫ Forward Testing: Once backtested, test your strategy on real market 
data (using a demo account is crucial). This assesses its resilience to 
unforeseen market events. Adjust your strategy based on the results, 
iterating until you achieve satisfactory performance. Never rely solely on 
backtested results. 

Phase 2: Translating Your Strategy into Code (MQL4/MQL5 or 
Python) 

This phase requires programming skills. MQL4/MQL5 are MetaTrader's 
programming languages, while Python offers greater flexibility and access to 
advanced AI libraries. 



⚫ Choose Your Programming Language: MQL4/MQL5 are ideal for 
direct integration with MetaTrader platforms. Python requires a bridge to 
connect to your broker's API. 

⚫ Code Your Strategy: Translate your entry and exit rules into code. This 
involves defining functions for indicator calculations, signal generation, 
order placement, and risk management. Organize your code efficiently for 
readability and maintainability. 

⚫ Implement Risk Management: Code your stop-loss and take-profit 
orders, position sizing logic, and potentially a maximum drawdown limit. 
Robust risk management is paramount in automated trading. 

⚫ Testing and Debugging: Thoroughly test your code on a demo account 
before deploying it to a live account. Identify and fix bugs diligently. This 
is where you'll catch undiscovered flaws in your strategy logic. 

Phase 3: Integrating AI (Optional but Recommended) 

Integrating AI can enhance your trading robot's decision-making capabilities. 

⚫ Select AI Techniques: Consider machine learning (ML) algorithms like 
neural networks, support vector machines (SVM), or reinforcement 
learning. These can help identify patterns and predict price movements, 
potentially improving accuracy and profitability. 

⚫ Data Preparation: Prepare your historical forex data for AI training. 
This involves cleaning, preprocessing, and potentially feature engineering. 

⚫ Model Training and Evaluation: Train your chosen AI model using 
your prepared data. Evaluate its performance using appropriate metrics. 
Remember that overfitting is a significant risk; consistently validate your 
model on unseen data. 

⚫ Integration with Trading Robot: Integrate your trained AI model into 
your trading robot code. This might involve using the model's predictions 
to refine entry/exit signals or dynamically adjust parameters. 

Phase 4: Deployment and Monitoring 

⚫ Demo Account Testing (with AI): Thoroughly test your AI-enhanced 
robot on a demo account. Monitor its performance closely and make 
adjustments as needed. 

⚫ Live Account Deployment (with careful risk 
management): Gradually deploy your robot to a live account, starting 
with a small capital amount. Continue monitoring its performance and 
make any necessary tweaks. 

⚫ Continuous Monitoring and Optimization: Regularly review your 
robot's performance. Market conditions change, and your strategy may 
require adjustments over time. Consider retraining your AI model 
periodically with updated data. 

 
 
 



Chapter 6: 

Implementing and Deploying the Robot 

 
How to Use a Forex Trading Robot : A Step-by-Step Guide 

Forex trading robots, also known as Expert Advisors (EAs), automate trading strategies, 
potentially saving time and improving consistency. However, using them effectively 
requires careful planning and understanding. This guide outlines how to use a forex 
trading robot with the FBS platform, emphasizing crucial considerations for responsible 
trading. 

Disclaimer: Trading forex involves significant risk, and using EAs doesn't guarantee 
profits. Thoroughly research any EA before implementing it, and understand you could 
lose your invested capital. 

Step 1: Choosing and Evaluating a Forex Trading Robot 

The most critical step is selecting a suitable EA. Don't be swayed by flashy marketing; 
instead, focus on these points: 

• Backtesting Results: Examine the EA's historical performance data. Look for 
consistent profitability across different market conditions. Be wary of results that 
seem too good to be true. Understand that past performance is not indicative of 
future results. 

• Strategy Transparency: A reputable EA will clearly explain its trading logic, 
including entry and exit rules, risk management parameters, and indicators used. 
Avoid "black box" EAs with opaque strategies. 

• Community Feedback: Look for reviews and discussions from other traders 
who have used the EA. Independent, unbiased feedback is invaluable. 

• Forward Testing: If possible, test the EA on a demo account before deploying it 
on a live account. This allows you to assess its performance in real market 
conditions without risking real capital. 

• Compatibility: Ensure the EA is explicitly compatible with the MetaTrader 4 
(MT4) or MetaTrader 5 (MT5) platform, as these are typically used with FBS. 

Step 2: Downloading and Installing the EA on the FBS MT4/MT5 Platform 

⚫ FBS Trading Platform : Allow all trading strategies and EAs, Low minimum 
deposit and fast deposit/withdrawal process 

⚫ Headway Trading Platform : More better trading platform for EA 
⚫ You can try DEMO trading first, Instal MT4 or MT5 to try and test your 

own Forex Trading Robot 
 
Once you've chosen an EA, you'll typically download it from the developer's website. The 
installation process is generally straightforward: 

1. Open your FBS MT4/MT5 platform: Log into your FBS account and launch 
the appropriate trading terminal. 

https://fbs.partners/?ibl=189948&ibp=1139486
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2. Navigate to the "Experts" folder: This location varies slightly depending on 
your operating system, but it's usually found within the MT4/MT5 installation 
directory. 

3. Copy the EA file: Copy the EA file (usually an .ex4 or .mq4 file) into the 
"Experts" folder. 

4. Restart the platform: Restart the MT4/MT5 platform to load the newly 
installed EA. 

5. Locate the EA: The EA should now appear in the "Navigator" window within 
the MT4/MT5 platform. 

Step 3: Attaching the EA to a Chart 

Now you'll need to attach the EA to a specific currency pair chart: 

1. Open the desired chart: Select the currency pair you wish to trade with the EA. 

2. Drag and drop: Drag the EA from the "Navigator" window onto the chart. 

3. Input parameters (if necessary): Many EAs require you to configure various 
parameters, such as lot size, stop-loss, and take-profit levels. Carefully review and 
adjust these settings according to your risk tolerance and trading strategy. 
Consult the EA's documentation for guidance. 

4. Enable the EA: Ensure that "Allow AutoTrading" is enabled in the "Tools" 
menu of the MT4/MT5 platform. This setting permits the EA to execute trades 
automatically. 

Step 4: Monitoring and Managing the EA 

Even with an EA, active monitoring is crucial: 

• Regularly check performance: Monitor the EA's performance closely, 
tracking its trades, profits, and losses. 

• Adjust settings as needed: Market conditions change, and you may need to 
adjust the EA's parameters to optimize its performance. 

• Implement risk management: Always use appropriate stop-loss orders to 
limit potential losses. Never risk more capital than you can afford to lose. 

• Be prepared to intervene: While an EA automates trading, you should be 
ready to manually intervene if necessary, especially during periods of high 
volatility or unexpected market events. 

Step 5: Understanding and Accepting the Risks 

Remember that using a forex trading robot does not eliminate risk. Market fluctuations, 
unforeseen events, and EA malfunctions can all lead to losses. Always trade responsibly 
and within your risk tolerance. 

This guide provides a general framework. Consult the specific documentation for your 
chosen EA and the FBS platform for detailed instructions and support. Remember to 
prioritize thorough research, risk management, and responsible trading practices. 

 
 
 
 



More guide how to test a Forex trading robot (Expert 
Advisor or EA) using Myfxbook 
 
Okay, here's a step-by-step guide on how to test a Forex trading robot (Expert 
Advisor or EA) using Myfxbook. This assumes you're using MetaTrader 4 
(MT4) or MetaTrader 5 (MT5) as Myfxbook primarily integrates with those 
platforms. It also assumes you already have a Myfxbook account. If not, create 
one first. 

Important Considerations Before You Start: 

• Backtesting is Crucial First: Before connecting to 
Myfxbook, thoroughly backtest your EA using MT4/MT5's Strategy 
Tester across different timeframes and market conditions. Backtesting 
helps you identify potential weaknesses, optimize parameters, and get a 
general idea of its performance. This guide focuses only on live/demo 
forward testing via Myfxbook. 

• Risk Management: Use a demo account for initial testing with 
Myfxbook. Do not risk real money until you are fully confident. 

• Broker Compatibility: Ensure that your EA is compatible with your 
chosen broker. 

• VPS (Highly Recommended): For reliable 24/7 performance, use a 
Virtual Private Server (VPS). A VPS ensures your MT4/MT5 platform 
(running your EA) stays online and active even when your computer is 
off. 

• EA Settings: Carefully configure your EA settings with appropriate 
risk parameters, money management, and trading preferences. 

• Realistic Expectations: No EA guarantees profits. Be prepared for 
both winning and losing trades during the testing period. 

• Terms of Service: Check Myfxbook's terms of service to ensure 
you're complying with their rules regarding automated trading and 
data sharing. 

Step-by-Step Guide to Testing with Myfxbook: 

1. Set Up Your MT4/MT5 Account: 

*   Choose a Broker & Account: (Example: FBS Trading Platform ) or  
Select a reputable Forex broker that supports MT4/MT5 and offers demo 
accounts. Open a demo account. *Start with a demo account!* 
*   Install MT4/MT5: Download and install the MT4 or MT5 platform from 
your broker's website. 
*   Log In: Log in to your demo account in MT4/MT5 using the account 
credentials provided by your broker. 
*   Install Your EA: Place your EA file ( `.ex4` or `.ex5` ) in the appropriate 
folder: 
    *   In MT4: `File -> Open Data Folder -> MQL4 -> Experts` 

*   In MT5: `File -> Open Data Folder -> MQL5 -> Experts` 
 

https://fbs.partners/?ibl=189948&ibp=1139486


*   Refresh the Navigator Panel:  In MT4/MT5's Navigator panel (usually 
on the left), right-click on "Expert Advisors" and select "Refresh".  Your EA 
should now appear in the list. 
*   Enable Auto Trading:  Make sure the "AutoTrading" button at the top of 
the MT4/MT5 platform is turned *ON* (usually green). 
 

2. Configure MT4/MT5 Settings for Myfxbook: 

• Enable WebRequest: Myfxbook uses WebRequest to gather data. 
You must enable this in MT4/MT5. 

o MT4: Tools -> Options -> Expert Advisors. Check the box 
"Allow WebRequest for listed URL". Add the Myfxbook 
URL: https://www.myfxbook.com (add it without the final "/") 
to the list of allowed URLs by pressing the "Add new URL" 
button below. 

o MT5: Tools -> Options -> Expert Advisors. Check the box 
"Allow WebRequest for URL". Add the Myfxbook 
URL: https://www.myfxbook.com to the list of allowed URLs, 
similarly to MT4. 

• Enable DLL Imports (Usually Not Needed, but Check): Only if 
your EA specifically requires DLL imports, make sure "Allow DLL 
imports" is checked in the same "Expert Advisors" settings window. Be 
very cautious with this setting as DLLs can pose a security risk. Most 
EAs don't need this. 

• Enable Live Trading: Also, in Tools -> Options -> Expert Advisors, 
make sure the option "Allow live trading" is checked. This is necessary 
even for demo accounts. 

• Chart Setup: Open the currency pair(s) your EA will trade on in 
MT4/MT5. The EA needs to be attached to a chart for it to function. 

 

3. Attach the EA to a Chart (In MT4/MT5): 

*   Drag and Drop: Drag the name of your EA from the Navigator panel onto 
the chart of the currency pair you want it to trade. 
 
*   EA Settings Window: An EA settings window will pop up. 
    *   Common Tab: Double-check "Allow Live Trading", "Allow DLL imports 
(if needed)", and "Allow WebRequest for URL" are enabled. 

*   Inputs Tab:  Configure your EA's parameters as needed. This is where 
you set things like lot sizes, risk percentages, stop-loss, take-profit, and other 
settings specific to your EA. *Start with conservative settings.* 

 
*   Click "OK":  The EA should now be attached to the chart. You should see a 
smiley face in the top-right corner of the chart if the EA is running correctly. If 
it's a sad face, there's likely an error. Check the "Experts" tab in the MT4/MT5 
terminal window for error messages. 
 



 
4. Connect Your MT4/MT5 Account to Myfxbook: 

*   Log in to Myfxbook:  Go to the Myfxbook website and log in to your 
account. 
*   Add Account: In Myfxbook, click on "Portfolio" and then "Add Account..." 
*   Select Platform: Choose "MetaTrader 4 (Auto Update)" or "MetaTrader 5 
(Auto Update)" from the platform options.  The exact wording may vary 
slightly. 
*   Enter Account Details: You'll need to provide the following information: 
    *   Account Name: Give your account a descriptive name so you can easily 
identify it in Myfxbook. 
    *   Broker: Select your broker from the list. 
    *   Account Number: Enter your MT4/MT5 account number. 
    *   Investor Password (Read-Only Password):  *Crucially, use the 
investor password, not your master password.*  The investor password allows 
Myfxbook to view your trading history but *cannot* be used to execute trades.  
If you don't have an investor password, you might need to create one in your 
MT4/MT5 platform (usually in your account settings or profile.) 
    *   Verify Password: Re-enter your investor password. 
*   Save and Authorize: Click "Save and Authorize". Myfxbook will attempt 
to connect to your account. 
*   Authorization Methods: If the "Auto Update" method doesn't work, 
you'll be presented with alternative authorization methods.  The most 
common is: 

*   Expert Advisor (EA) Method: Myfxbook will provide you with a 
special EA to download and attach to a chart. It's a simple EA that just sends 
authorization data to Myfxbook. Follow the instructions on Myfxbook's site to 
download, install, and attach this EA. This is often the most reliable method. 
The other methods that Myfxbook sometimes offers are 'Publisher' (using an 
external publisher app - less common) and 'Custom period' (requiring a 
specific period of trading history). 

 
5. Configure Myfxbook Settings: 

*   After Authorization: Once your account is successfully authorized, 
Myfxbook will import your trading history.  This may take a few minutes or 
longer, depending on the size of your history. 
*   Edit Account Details: Go to your portfolio and click on the newly added 
account.  Click the "Edit" tab. 
*   System Name:  Give your system a name that reflects your EA or trading 
strategy. 
*   Description (Optional):  Provide a description of your EA and your 
testing goals. 
*   Privacy Settings:  *This is very important.*  Control what information is 
visible to the public (or to specific groups).  You can choose to hide your 
balance, equity, open trades, and other details.  Consider these settings 
carefully, especially if you are using a live account, even if it's just a small live 
account. 
*   Comments: You can add comments to individual trades to track your 
analysis or document issues. 



*   Magic Number:  If your EA uses a magic number, enter it in the 
Myfxbook settings. This helps Myfxbook accurately track trades made by your 
EA.  If your EA *doesn't* use a magic number, leave this blank. 
 

6. Monitor and Analyze Performance: 

*   Track Results:  Myfxbook will automatically update your account 
statistics.  Monitor the key performance metrics regularly: 
    *   Profit/Loss: Track your overall profit or loss. 
    *   Drawdown: Pay close attention to your drawdown (the peak-to-trough 
decline in your account balance).  High drawdown indicates higher risk. 
    *   Win Rate:  The percentage of winning trades. 
    *   Profit Factor:  The ratio of gross profit to gross loss.  A profit factor 
above 1.0 generally indicates a profitable system. 
    *   Sharpe Ratio: A measure of risk-adjusted return.  Higher is better. 
    *   Average Trade Length:  The average duration of your trades. 
*   Analyze the Trading History:  Review the individual trades to identify 
patterns, strengths, and weaknesses in your EA. 
*   Adjust Parameters:  Based on your observed performance, you may need 
to adjust your EA's parameters to optimize its performance.  Remember to 
make small, incremental adjustments and test thoroughly. 
*   Compare to Backtesting:  Compare the results of your Myfxbook testing 
with your backtesting results.  Significant discrepancies may indicate that 
your backtesting environment was not representative of real-world market 
conditions. 
 

Troubleshooting: 

• EA Not Trading: 

o Check the "AutoTrading" button is ON. 
o Check the "Experts" tab in the MT4/MT5 terminal for error 

messages. Common errors include "Trade disabled", "Not 
enough money", "Invalid stops", etc. 

o Ensure the EA is attached to a chart of the currency pair it's 
supposed to trade. 

o Verify your EA settings are correct (lot size, risk parameters, 
etc.). 

o Check the EA's logs (usually in the Files folder under your 
MT4/MT5 data folder) for more detailed error information. 

• Myfxbook Not Updating: 
o Double-check your investor password. 
o Verify that WebRequest is enabled correctly in MT4/MT5. 
o Make sure the Myfxbook URL is in the list of allowed URLs. 
o Check Myfxbook's website for any known issues or maintenance 

periods. 
o Try the EA method of account authorization. 
o Wait for a few hours - sometimes there are delays in data 

synchronization. 



Key Considerations for Successful Testing: 

• Sufficient Testing Period: Test your EA for a significant period (at 
least several weeks, preferably months) to gather enough data to assess 
its performance across different market conditions. 

• Real Market Conditions: Remember that demo accounts may not 
perfectly simulate real-world trading conditions (e.g., slippage, 
liquidity, spreads). 

• Regular Monitoring: Monitor your EA's performance daily and 
review your overall results weekly or monthly. 

• Transparency and Documentation: Document your testing 
process, including your EA settings, parameters, and any changes you 
make. 

• Be Patient: Testing and optimizing an EA takes time and effort. Be 
prepared to iterate and refine your approach. 

By following these steps, you can effectively use Myfxbook to test your Forex 
trading robot in a live or demo environment, gather valuable performance 
data, and improve your trading strategy. Remember to prioritize risk 
management and test thoroughly before risking real money. Good luck! 

 
 

 

 

 

 

 

 

 

Chapter 7: 



Optimizing and Scaling Your Forex Trading 

Robot 

In this chapter, we explore how to refine and expand your AI-powered Forex 

trading robot to ensure it remains effective and scalable in dynamic market 

conditions. Optimization and scaling are critical for maintaining performance, 

adapting to changes, and handling more complex trading scenarios. 

 

7.1 Continuous Learning and Model Updates 

⚫ Why It Matters: Markets evolve, and your robot must adapt to stay 

relevant. 

⚫ How to Do It: Use online learning, regular retraining, and reinforcement 

learning to keep your AI model updated. 

⚫ Tools: TensorFlow, PyTorch, and cloud platforms like AWS or Google 

Cloud. 

 

7.2 Adapting to Changing Market Conditions 

⚫ Market Regimes: Identify trends, ranging, or volatile conditions and 

adjust strategies dynamically. 

⚫ Dynamic Strategy Switching: Implement multiple strategies (e.g., trend-

following, mean reversion) and let the robot choose the best one. 

⚫ Risk Management: Use stop-loss orders and position sizing to handle 

unexpected events. 

 

7.3 Scaling for Multiple Currency Pairs 

⚫ Why Scale? Diversify your portfolio and reduce risk by trading multiple 

pairs. 

⚫ Challenges: Handle correlations between pairs and increased 

computational demands. 

⚫ Strategies: Use parallel processing, correlation analysis, and efficient 

resource allocation. 

⚫ Tools: Cloud-based solutions and load balancing techniques. 

 



7.4 Ethical and Legal Considerations 

⚫ Ethical Use: Ensure transparency and fairness in your robot’s decision-

making. 

⚫ Legal Compliance: Follow regulatory requirements and broker policies. 

⚫ Avoid Manipulation: Steer clear of practices like spoofing or layering. 

 

7.5 Future Trends in AI-Powered Forex Trading 

⚫ Explainable AI (XAI): Make AI decisions more transparent. 

⚫ Quantum Computing: Leverage quantum algorithms for faster 

optimization. 

⚫ Decentralized Finance (DeFi): Explore blockchain-based trading and 

smart contracts. 

 

Conclusion 

Optimizing and scaling your AI Forex trading robot is an ongoing process. By 

continuously updating your model, adapting to market changes, and scaling 

efficiently, you can ensure long-term success. Stay ahead of trends like 

quantum computing and DeFi to maintain a competitive edge. 

 

Key Takeaways 

⚫ Continuously update your AI model to adapt to market changes. 

⚫ Use dynamic strategies and robust risk management. 

⚫ Scale efficiently to trade multiple currency pairs. 

⚫ Ensure ethical and legal compliance. 

⚫ Stay informed about future trends in AI and trading technology. 

 

By following these steps, you can build a resilient, scalable, and future-proof 

Forex trading robot. 

 

 

More popular Forex trading platforms that are generally 
considered good for using Forex trading robots 



here's a list of 10 popular Forex trading platforms that are generally 
considered good for using Forex trading robots (Expert Advisors or EAs). 
Keep in mind that "best" is subjective and depends on your individual needs, 
experience level, and trading style. This list is based on factors like EA 
compatibility, platform features, reliability, and community support. 

Important Considerations Before Choosing: 

• Backtesting Capabilities: How well can you test your EAs on 
historical data before risking real money? 

• VPS Compatibility: Can you easily run the platform on a Virtual 
Private Server (VPS) for 24/7 automated trading? 

• Programming Language: Most EAs are written in MQL4 or MQL5. 
• Community and Support: A strong community can provide 

assistance, resources, and shared EAs. 
• Broker Compatibility: Ensure the platform works with a reputable 

broker that offers good trading conditions (low spreads, fast execution). 
• Cost: Some platforms are free, while others have subscription fees. 
• User-Friendliness: Is the platform easy to learn and use, especially 

when setting up and managing EAs? 
• Mobile Trading: Does the platform offer a good mobile app for 

monitoring your EAs on the go? 
• Regulations: Ensure the broker offering the platform is regulated by 

a reputable body. 

Top 10 Forex Trading Platforms for Robots (EAs): 

1.MetaTrader 4 (MT4): The industry standard. Almost all brokers 
offer it. Excellent for beginners and experts alike. Huge community and 
a massive library of free and paid EAs. Uses MQL4. Strong backtesting 
capabilities. Widely supported by VPS providers. 

o Pros: Universally accepted, huge library of EAs, robust 
backtesting, easy to learn. 

o Cons: MQL4 language is older, can be slower than MT5 in some 
situations. 

2.MetaTrader 5 (MT5): The successor to MT4. Faster, more 
powerful, and supports more order types and timeframes. Uses MQL5 
(more advanced than MQL4). Offers better backtesting and 
optimization capabilities. Gaining popularity but not as widely 
supported as MT4 yet. 

o Pros: Faster, more features, MQL5 is more powerful, better 
backtesting. 

o Cons: Not as widely supported as MT4, MQL5 requires learning 
a new language (if migrating from MQL4). 

3.cTrader: A platform known for its depth of market (Level II pricing) 
and fast execution speeds. Popular with experienced traders. Uses C# 



for automated trading (cBots). More transparent pricing and order 
execution than MT4/MT5 in some cases. 

o Pros: Depth of market, fast execution, C# programming for 
cBots. 

o Cons: Smaller community than MT4, requires knowledge of C#. 

4.NinjaTrader: A powerful platform popular with futures and Forex 
traders. Offers advanced charting, backtesting, and automated trading 
capabilities. Uses NinjaScript (C# based). Can connect to a variety of 
brokers. 

o Pros: Powerful charting, advanced backtesting, C# based 
NinjaScript. 

o Cons: Can be more complex to learn, may require a paid license 
for advanced features. 

5.TradingView: Primarily known for its excellent charting and social 
trading features. While not traditionally an EA platform, it now allows 
for automated trading through brokers that support TradingView's API. 
TradingView Pine Script is used to write automated strategies. 

o Pros: Excellent charting, social trading features, growing 
support for automated trading. 

o Cons: Relies on broker API integration for automated trading. 
The range of brokers supporting EA is limited. 

6.MultiCharts: Another powerful platform, popular with experienced 
traders who use more sophisticated strategies. Offers advanced 
charting, backtesting, and automated trading capabilities through 
PowerLanguage (similar to EasyLanguage). 

o Pros: Advanced charting, robust backtesting, supports multiple 
data feeds. 

o Cons: Can be expensive, steep learning curve. 

7.ProRealTime: A web-based platform known for its advanced 
charting and analytical tools. It allows for automated trading through 
its ProBuilder language. 

• Pros: Web-based (accessible from anywhere), extensive charting tools, 
powerful backtesting. 

• Cons: Can be costly, reliance on internet connection. 
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8.TradeStation: A well-established platform popular with serious 
traders. Offers advanced charting, backtesting, and automated trading 
through EasyLanguage. 



o Pros: Long history, robust platform, EasyLanguage is relatively 
easy to learn. 

o Cons: Can be expensive, requires a TradeStation brokerage 
account. 

9.IG Trading Platform: IG is a large, reputable broker with its 
proprietary platform. Offers automated trading functionality via LUA 
scripting language. 

o Pros: Reputable broker, advanced charting and analysis 
capabilities, LUA scripting support. 

o Cons: May have limitations compared to dedicated EA 
platforms like MT4, limited range of brokers 

10.Interactive Brokers Trader Workstation (TWS): While 
primarily known for stocks and options, TWS supports Forex trading 
and has an API that allows for automated trading. Requires 
programming knowledge (Java, Python, etc.). 

o Pros: Access to a wide range of markets, powerful API, low 
commissions. 

o Cons: Steeper learning curve, requires programming skills, may 
not be as user-friendly for beginners. 

Important Notes: 

• Demo Accounts: Always test your EAs thoroughly on a demo account 
before risking real money. Make sure the demo environment accurately 
reflects live trading conditions. 

• Broker Compatibility: Confirm that the platform and your chosen 
broker are compatible with EAs. Some brokers may restrict certain 
types of automated trading. 

• Risk Management: EAs are not a guaranteed path to profits. 
Implement proper risk management strategies (stop-loss orders, 
appropriate position sizing). 

• EA Quality: Be skeptical of EAs that promise unrealistic returns. 
Research and choose reputable EAs from trusted sources. Consider 
coding your own EA if you have the skills. 

• VPS: Using a VPS is highly recommended for running EAs 24/7, 
especially if you have a strategy that requires constant monitoring. 

Before making a decision, I highly recommend exploring the demo versions of 
several platforms and reading reviews from other traders. This will help you 
find the platform that best suits your individual needs and trading style. Good 
luck! 

Grant of Resale Rights: The Licensor grants the Licensee the 
non-exclusive right to resell this ebook in its original format (PDF). 
The Licensee may not modify the content of the ebook or alter its 
branding. The Licensee is responsible for all aspects of reselling 



the ebook, including marketing, sales, and customer service. This 
license is perpetual. 
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